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1 Introduction

This styling guide has been created to explain how to load and manage the styles that accompany
Meridian™ 2. Within this document the customer will find an explanation of the styles

Ordnance Survey has opted to use, information about loading the styles and altering the styles to suit
their needs.

2 Background

Responding to customer feedback about our OS OpenData™ products Ordnance Survey has
produced styled data for Meridian 2 in two major formats: MapInfo TAB and ESRI Layer files. These
two formats are widely used and will serve a large proportion of OpenData users. Customers can opt
to use the styles Ordnance Survey has provided or they can customise them to suit their individual
needs. Within this styling guide you will find details of how to achieve this.

Ordnance Survey has adopted the backdrop styles applied to the OS VectorMap® products. The styles
have been designed to aid customers in their representation of the data for a variety of purposes.
Primarily they enable customers to view the data in a geographical information system (GIS) and
overlay their own data onto Meridian 2. They also aid in the combination of Meridian 2 with other
similarly styledgroducts in the OS OpenData range, like Strategi® (small scale) and

OS VectorMap™ District (mid scale) within a GIS.

Maplnfo and ESRI manage the data and styles in slightly different ways and consequently there will be
minor differences between some of the feature styles. For example, roads in ESRI have road casings

applied but they do not in Maplinfo, however, these can be applied by the customer upon receipt of the
data.

3 Mapinfo TAB

The styled data will open in versions of Mapinfo back to Maplinfo Professional v7.5. We have not
tested it back further than this.

3.1 How to load the styles

Maplnfo Professional 11.0.4 has been used to create the screenshots in the following instructions but
the functionality will be similar in most versions.

Styling for Mapinfo TAB is hard coded into the data itself so customer’s only have to load the data.
Open a blank workspace in MapInfo Professional.
Go to File > Open and navigate to the Meridian 2 TAB files, highlighting those to open.

From the Preferred View drop-down list select New Mapper (Figure 1).
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Open

Look in: | () Meridian 2 TAB

RoadNode. TAB

i E A_road. TAB
]

Tables lo||B_road. TAB
Directory ]| Coast_Ln.TAB

' (=] county. TAB

BEEEDE

Remote Tables
Directory

- ]| Lake. TAB
Import Files otorway. TAB
Directory I LF orway.TAB
[=Rail_Ln. TAB
- River. TAB
Workspaces
Directory
File name: I"Woodland.TAB" “4_road. TAB" "Admin_Ln.T VI [ Open I
Files of type: I Maplnfo (*.tab) v | [ Cancel ]
Preferred View: I New Mapper v | [ Help ]
(® Maplnfo Places Create copy in Maplnfo format for read/write
O Standard Places

Figure 1 Load TAB files in a New Mapper

Click Open.

In the Layer Control window arrange the layers as they appear in Figure 2. The layers do not open in
this order when you load them. The TAB files load in the following order:

1 By geometry type:
Point
Line
Polygon

2 Then alphanumerically.

Several layers are not displayed because they detract from the overall effectiveness of the styling.
They can be displayed by checking the tick box before the layer name.
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Layer Control B x
aw
Cosmetic Layer

O

O

O

O

Aa  text 3
Station '
Admin_Ln %
Rail_Ln 9
Motorway \
A_road %
B_road %
Minor_rd Q
Coast_Ln %
Lake %
River Q
DLUA %
woodland %
District 3
County Q

Figure 2 Suggested layer order for TAB file

This is only a recommendation and the customer’s requirements for layer order and layer visibility may
differ.

The optimum viewing scale for Meridian 2 is 1:50 000 and our recommended viewing range is
1:25 000-1:75 000 although there are no minimum and maximum scale restrictions

Viewing the data at scales larger than 1:25 000 works reasonably well but when viewing it at scales
smaller than 1:75 000 the styles start to degrade.

3.2 How to set the scale range

In the Layer Control panel, right click on the title and choose Map Options.

Layer Contraol 3 x
= ﬁs N —
Rename
| Map Options... |
O Add Group

Figure 3 Set the scale range — Map Options
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In the Map Options window change the Distance Units to centimetres.

r N

Map Options @
Map Units Distancesbrea using:
i ] () Spherical
Coordinate Units: { metres v ‘ O Cartesian
Distance Units: [ v ‘

[ Image Processing... ]

Area Units: ’ square metres v ‘

[ Projection... ]

Figure 4 Set the scale range — Distance Units
Click OK to close the Map Options window.

Right click on your map and choose Change View.

Layer Contral...

A\

Find Selection

Yiew Entire Selection Layer

Select all from Selection Layer

Make Selection Layer Editable

Turn Autoscroll OFF

Clear Cosmetic Laver

?{ Change Yiew...
Clone Yiew
Previous View

View Entire Layer...

Edit Objects »

Get Info...

Figure 5 Set the scale range — Change View

In the Change View window input the Map Scale and click OK.

Change View

Zoom [Window Width): 2,170,000 cm

Map Scale: 1cm= cm
Center of Window: »: 279,400 m Y: 885,900 m

[ 0K I[ Cancel ][ Help ]

Figure 6 Set the scale range — Map Scale
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3.2.1 Define a background colour in Mapinfo

There are two options to add a colour to represent the sea.

1  Create a polygon that covers the map extent, place it at the bottom of the Layer Control panel
and style it accordingly. The recommended sea colour is R228 G244 B247. See 3.3.5 for setting
colour values.

2 Alternatively change the Windows display parameters. One caveat is that every window on this
machine will have the new background colour.

For further information please refer to:

http://testdrive.mapinfo.com/techsupp/miprod.nsf/2dcd2e03799251b185257125006b1089/12b94a7dd
1dc2fa1852569460058a9d7?0OpenDocument

3.3 How to customise the styling

3.3.1  How to style the data using a Style Override

Using Style Override will alter the styling in a particular edit session or in a saved Workspace without
permanently overriding the default styles. Users can revert back to the default styling.

In the Layer Control panel select the layer to style and right mouse click to open its Layer Properties
window.

On the Layer Display tab tick the box for Style Override.

r ~

Layer Properties : Lake @

Layer Display | Label Display | Labeling Rules

Display Mode Zoom Layering
Style Override | [] Display within Zoom Range:

m Min. Zoom: cm

Max Zoom: cm

[] Use Stacked Styles

Enhanced Rendering
[] Show Line Direction

Translucency J 0 = [] Show Nodes
[T] Show Centroids
[ oK ] [ Cancel ] [ Preview ] [ Help ]

Figure 7 Style Override

Click on the button below the Style Override to open the Style window (this could be Region, Line or
Symbol depending on the type of feature selected).

In the Style window (Figure 8), set the desired style then click OK.
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S Region Style

Layer D) Fil

Displ Pattern:

: Fi d I :
oreground:
Help
l [1 [“Background: I :
O Border cm
i

G — — — — — — — — — —. :l

Ehel  Coor [ ]

Trang Width
(®) Pixels _ :
O Paints
Sample
P Y T, . a

Figure 8 Style Window

Click OK on the Layer Properties window and the new style will appear in the Map Window. To
remove the Style Override, untick the box in the Layer Properties window.

Styles set using a Style Override can be saved in a Workspace but will not be hard-coded to
the data.

3.3.2 How to style the data using selections

This method of styling gives the User the ability to style features in the same layer differently based on
a selection. Default styles using selections will be permanently removed as they are hard coded in the
data.

In the Layer Control panel select the layer to style and make it editable by clicking on the ff button.

Woodland
District

B ooy E
Editable: Onl

F A

I

Figure 9 Editable layer

On the main toolbar click on Query > Select to open the Select window (you can also use SQL Select
to build more complex queries).

Meridian 2 styling guide
v1.0 Dec 2012 © Crown copyright
D10200 Page 9 of 25



Styling guide

Query | Table Options Map W
| Select...
SQL Select...

Select All from Settlement

Invert Selection

# nselect All Chrl+w
Find... Ctrl+F
Find Selection >

ﬁ Find Address...

Calculate Statistics. ..

Figure 10 Select Query location

In the Select window, add an expression to filter the data. If required use the Assist button to help.
This opens up the Expression window (Figure 11).

[« o

Expression @

Type an expression:

| I Columns EI

Operators

i

Functions

[ 0K l[ Cancel ] [ Verify ][ Help ]

Figure 11 Expression window

Make sure that the Browse Results and Find Results in Current Map Window boxes are unticked and
click OK (Figure 12).

| Select @

q

Select Records from T able: [ County v }
that Satisfy: Mame = "NON COUNTY"{ ‘
Agsist...
Store Results in Table: lSeIeolion ‘

41 none A }
[] Browse Results [C] Find Results In Current Map Window

I 0K I [ Cancel l [Save Template] [Load Templa!e][ Help l

Figure 12 Select query example

On the main toolbar click Options and select the style option that is relevant to the layer being styled —
line, region, symbol or text (Figure 13).
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Options I Map ‘Window Help

N Line Style... Shift+Fg
|d Region Style. .. Ctrl+F8
@ symbol Style... Alt+F3
A Textstyle... F3

Toolbars...
Show Theme Legend Window
Show Statistics Window

ST

Show MapBasic Window
Hide Status Bar

Custom Colors...

Preferences...

Figure 13 Styling Options

Select your desired style in the style window (Figure 14).

=
Region Style @
Fill
oK

Pater:  [eeRRRRrR & -
R

Foreground:
-Help
[¥] Background: : -

Border

Style: _— :

Color:
Width
(®) Pixels [ :
O Points
Sample

Figure 14 Styling Example
Click OK and the new style will appear in the Map Window.
It is possible to make multiple selections on the same layer and style its features differently.

In order to save this new styling it needs to be hard-coded to the data. On the main toolbar click File >
Save Table, select the relevant table and click Save.

NOTE: this will overwrite the default style of the TAB which will not be retrievable once saved.

3.3.3 How to add labels

In the Layer Control panel select the layer to be labelled and right mouse click to open its Layer
Properties window (Figure 15).

Click on the Label Display tab and select the attribute field to be used for labelling.
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Layer Properties : A_road @

Layer Display | Label Display ’ Labeling Rules

Label with: | Road_Mame v

Feature_Code
0SODR

Styles

Road Name

Trunk_l_ndicator

Translucency [Expression... }
N | I

Enhanced Rer

7N

Placement
Default Position

@ @ @ O Horizontal Labels Label Dffset
[a [E] O Rotate labels with segments E Points

E] E] [z] (%) Curve labels along segments

[ oK ][ Cancel ][ Preview ][ Help ]

Figure 15 Attribute field selection

Alternatively, select Expression and customise the labels.

For more information see this tutorial:
http://www.pbinsight.com/support/education/video-tutorials/detail/label-with-expressions/
Use the Label Display and Labelling Rules tabs to set your label styles and placement rules.

In the Layer Control window turn Automatic Labels on for the layer that you want to label.

Rail_Ln A &
Motorway .
O |
B_road & ] Automatic Labels: On I
Minor_rd Q
Coast_Ln "

Figure 16 Automatic Labels Selection

The labels will now appear in the Map Window.

3.3.4 How to create road casings using Stacked Styles
It is possible to add road casings which may enhance the road styles against the other map features.

Stacked Styles is a feature that was introduced to Maplnfo Professional at version 10.5. If using an
older version of Maplnfo Professional, skip to the next section.
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In the Layer Control panel select the road layer to be styled and open its Layer Properties window.

In the Layer Properties window under the Layer Display tab tick the boxes for Style Override and Use
Stacked Styles (Figure 17).

Layer Prope

rties : A_road

Layer Display | Label Display || Labeling Rules |

Erreptarirbert Zoom Layering
Style Override [] Display within Zoom Range:

Use Stacked Styles

Max Zoom: | 10,000,000

Enhanced Rendering

Translucency 37 % [[] Show Nodes

[] Show Line Direction

[] Show Centroids

Styles for New Objects

(

0K ][ Cancel ][ Preview ][ Help ]

Figure 17

Click on the button to open the Stacked Line Styles window.

Stacked Styles tick box

>

Click Add so two styles appear in the Style list.

Layer Properties : A_road @

Stylg

Use

Enhanc

Transhu

Layer Display | Label Display | Labeling Rules |

Display b

e 2o
Stacked Line Styles
Style list: ] cm
I Add I Sample ] om
| X

[ OK ][ Cancel]

[ oK ][ Cancel ][ Preview ][ Help ]

Figure 18

Stacked Styles
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Click on each button in turn and select the style, colour and width. The style for the layer on top,
for the road fill, should be thinner than the style underneath for the road casing. See 3.3.5 for
amending the Colour (RGB) values. These are the recommended values.

Road feature Colour (R,G,B) Width (in pixels)
Motorway fill 99, 200, 221 6
Motorway casing 112,112, 112 7
A Road fill 255, 187, 210 5
A Road casing 144, 144, 144 6
B Road fill 253, 211,177 4
B Road casing 144, 144, 144 5
Minor Road fill 255, 244, 225 2
Minor Road casing 176, 176, 176 3

Table 1 Recommended road casing values

Click OK on the Layer Properties window and the new style will appear in the Map Window. To
remove the Style Override, untick the box in the Layer Properties window.

Repeat these steps for each of the road layers.
3.3.5 Setting the colour (RGB) value

Click on each button to open the Style window (Figure 19).

Click on the Color drop-down to open the colour palette.

r |

Line Style @

Syle: [——— 2]
Coior: [ | +] |  Sevole

T
(® Pixels | R I : | ><

O Points

Figure 19 Style window

To set a new colour value click on the three dots in the bottom right-hand corner to open the Pick
Color window and enter either the recommended values or some new values.
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X
A|BIC|D[E|F[G[H|I[J|K]|L[M|N|0O|P

B

[]

W~ 3O W N =

w

10 ]
1 [
12

13

14

15

16

17

Figure 20 Colour palette

Hue: I: Red: Z:
Sat: L: Green: |0 l Cancel l
v [0 e o

Figure 21 Pick Color window

3.3.6 How to create road casings and customise the road fills using
multiple layers

The following instructions explain how to style roads with road casings. This type of styling cannot be
hard coded to the data before Ordnance Survey supplies it but can be saved in the Workspace by the
Customer. Two copies of each road TAB file will need to be loaded into the Workspace; one for the
road casings and the other for the road fill.

On the main toolbar go to File > Open and navigate to the Meridian 2 TAB files, highlighting the road
file to be opened (the one to add a casing to). From the drop-down list select Current Mapper as the
Preferred View.

In the Layer Control panel, move the new road layer so it sits below the matching one that was already
open in the Layer Control list (Figure 22).

Motorway %
A_road %
B_road %

Figure 22 Multiple layers

Open the Layer Properties window for the new layer and tick the box for Style Override.
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Click on the button to open the Line Style window.

Select the desired road casing style. These are the recommended values for the casings.

Road feature Colour (R,G,B) Width (in pixels)
Motorway casing 112,112, 112 7
A Road casing 144, 144, 144 6
B Road casing 144, 144, 144 5
Minor Road casing 176, 176, 176 3

Table 2 Road casing style recommended values
Click OK on the Layer Properties window and the new style will appear in the Map Window.
Repeat these steps for each of the roads layers.

Repeat these steps for the road layer that is on top in the Layer Control panel to customise as road
fills.

Motorway [

B_road S
Figure 23 Style the road casing

Use these recommended values to create the road fill.

Road feature Colour (R,G,B) Width (in pixels)
Motorway fill 99, 200, 221 6
A Road fill 255, 187, 210 5
B Road fill 253, 211,177 4
Minor Road fill 255, 244, 225 2

Table 3 Road fill style recommended values
The Map Window will display the new styling and the roads will have a casing.

Repeat these steps for each of the roads layers.

4 ESRI Shapefile

For ESRI Users Ordnance Survey has produced a Layer file (.lyr) which, when stored with the data
enables users to drag and drop the file into ESRI ArcMap to draw up the styles automatically. This is
dependent on the User storing the data together with the Layer file. If this doesn’t happen the User
can re-link one of the styles in such a way that the rest will re-link automatically, as long as all of the
product ESRI Shapefiles are stored in the same folder.

Meridian 2 styling guide
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The ESRI styles have been created using ArcMap 10 and have been made backwards compatible as
far as ArcMap 8.3. ESRI ArcMap’s standard labelling engine has been used rather than Maplex as this
is not available in older versions of the software and users may not have this additional functionality in
their GIS. Text placement has been partially controlled when designing the styles but much of it is
automatically placed by the software depending on the position of other text and features.

4.1 How to load the styles

The ESRI Shapefiles for Meridian 2 and an ESRI ArcGIS Layer File called Meridian_2.lyr are in the
folder called DATA.

This Layer File is compatible with versions of ESRI ArcGIS 10 back to version 8.3 (released in 2002).

ESRI ArcMap10 has been used to create the screenshots in the following instructions but the
functionality will be similar in most versions.

NOTE: before loading the layer file info ArcMap please ensure the layer file is contained within the
same folder as the data.

Open a new, blank map in ArcMap.

There are three ways to load the data

1 Double click on the layer file -~ Meridian_2

2 Drag the Meridian_2.lyr file into the Table Of Contents.

8 S8 [
k=
= Meridian 2

# [ settlemt_point
I O rndabout_point
roadnode_point
text
junction_font_point
admin_In_palyline
station_point
rail_In_polyline
Road Fills group
Road Casings group 1
Road Casings group 2
coast_In_polyline
lake_region
river_polyline
dlua_region
woodland_reqion
county_region
district_region

=+ |

B E BB E

NEREEEEREREKRERRO

+ =

I+

®H ®

i+

B E BB E

Table 4 ESRI Table Of Contents

Several layers are not displayed because they detract from the overall effectiveness of the styling.
They can be displayed by checking the tick box before the layer name.

3  Click on the add data button and select the layer file and click Add (Figure 24).
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“ Untitled - ArcMap - Arcinfo

File Edit VYiew Bookmarks Insert Selection Geoprocessing Customize Windows Help
D286 58 x 9 odfl: 1:100,000 l-m%-msmw *d-a“«f'n
(38 @ @ ﬂ Export Map Styled... [ i Editor ~ - Labeling x.ﬂ
gcﬁnteg 5 SR 1 4 Data
% 8 =
=T ayers] Lookin: IE Meridian_2 v‘ & &3 =)
@a_road |_polyline.shp “Meridian 2.lvr [%Jtext.shp
| =] admin_ln_polyline.shp Dmlnor rd_polyli p  [Ewoodland_region.shp
|=Jb_road_polyline.shp o inefhp
Scoast_ln _polyline.shp Drall In, Jjolyllne shp
Ed) county_region.shp [Sriver_polyline.shp
B district_region.shp [%Irndabout_point.shp
Ed)dlua_region.shp [“Jroadnode_paint.shp
“.*Jjunction_font_point.shp [ settlemt _point.shp
Ed)lake_region.shp (%) station, _point.shp
Name: | Meridian_2.lyr ‘ I Add ]
Show of type: |Datasets and Layers V‘ [ Cancel ]

Figure 24 Add data button

NOTE: if the layers do not automatically link to the data, re-link to the data source by following the next

instructions.

To fix broken links to multiple layers right click on the layer name next to the red exclamation mark.

Click on Data = Repair Data Source.

Of Contents

8G8
= =/ Layers
=] Meridian 2

[} settlemt_point

[¥ rndabout_point

[} roadnode_poaint

DES g o,

[ZF junct

[} admit X Remove

[} statiq [

[0 rail_ )

Road Joins and Relates >

Roag |

Road =

[P coasl

O lake_ Visible Scale Range »

[ river Use Symbol Levels

[F dlua )

2 wood Selection >

[} coun| ~

I distri Edit Features >
| Data » ”‘\:\i Repair Data Source. ..
< Save As Layer File... »
@ Create Layer Package. .. Export to CAD...
[ Properties...

&

Figure 25 Repair data source

In the Data Source window browse for the relevant ESRI Shapefile and click Add.
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411 Set a reference scale

In the Table Of Contents panel right click on Layers and choose Properties to open the Data Frame
Properties window (Figure 26).

In the General tab type 1:50 000 in to the Reference Scale box then click OK.
The optimum viewing scale for Meridian 2 is 1:50 000 and our recommended viewing range is
1:25 000-1:75 000 although there are no minimum and maximum scale restrictions set in the

layer file.

Viewing the data at scales larger than 1:25 000 works reasonably well but when viewing it at scales
smaller than 1:75 000 the styles start to degrade.

Data Frame Properties

mrr§roups | Extent Indicators | Frame Size and Position | Product Library
General | PataFrame | Coordinate System | lllumination | Grids Feature Cache

MName: ' Lavers
Description:
Credits:
Units
Map:
Display: | Meters v

Tip:  See Customize > ArcMap Options > Data Yiew tab for
additional options for displaying coordinates in the status
bar

Reference Scale: 1:50,000 v
Rotation: v 0
Label Engine: ESRI Standard Label Engine v

Simulate layer transparency in legends

[ oK ][ Cancel ]

Figure 26 Data Frame Properties to set the Reference Scale

4.1.2 Define a background colour
To add a colour for the sea, define a background colour for your Data Frame.

In the Table Of Contents panel right click on Layers and choose Properties to open the Data Frame
Properties window (Figure 27).

In the Frame tab choose a background colour to input new colour values using the drop-down Color
button.

Ordnance Survey recommends R228 G244 B247 which matches the lake colour.
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~

Data Frame Properties

-

@3

Feature Cache |

General | DataFrame | Coordinate, jnation | Grids
Annotation Groups | Extent Indicator: | Frame ‘ ize and Position | Product Library |
e

Border

Background

[E]

‘ W i
i

Gap X: pts VY:

Drop Shadow
(]
v
‘ H|

a3

[C] Draft mode - just show name

‘ l—v Color:
Gap X pts Y: pts  Rounding:

Color:

pts  Rounding:

B

B

il g

3

[ 0K ][ Cancel ][ Apply

J

Figure 27 Data Frame Properties for sea colour

41.3 Ordering the ESRI layers

When the Layer file is loaded there are layers that have been turned off and some that have grey ticks

next to them.

Table OF Contents

55
= Meridian 2

O settlemt_point

O rndabout_paint

O roadnode_point

text

) junction_Font_point

admin_In_polyline

station_point

rail_n_polyline

Road Fills group

Road Casings group 1

[ motorway_polyline
@otorway casing 1

[J] a_road_polyline
@ 4 Road casing 1

[Z] b_road_polyline
@==B Road casing 1

[ minor_rd_polyline

Minor Road casing 1

3]

#

)

0EeeEE®®
nm NRRRRER

1]

1]

] Road Casings group 2
+ coast_In_polyline

[+ lake_region

* river_polyline

® dlua_region

@ woodland_region

@ county_region

& district_region

Figure 28 Layer ordering
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The layer order and visibility of the layers have been set to suit Ordnance Survey’s recommended
viewing scales of 1:25 000-1:75 000. This is only a recommendation and each customer’s
requirement for layer order and layer visibility may differ.

The layers with grey ticks have scale ranges set. These layers will turn on and off automatically

depending on the viewing scale.

These scale ranges can be changed or turned off by navigating to the General tab within the Layer

Properties window (Figure 29).
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Figure 29 Altering scale ranges

4.2

421 How to add labels

How to customise the styling

In the Table Of Contents panel right click on the layer that you want to label and choose Properties.

In the Layer Properties window click on the Labels tab (Figure 30).

Tick the box for Label features in this layer, set the Method and select the attribute field for labelling

from the Label Field drop-down list.
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Layer Properties @
General | Source | Selection | Display | Symbology | Fields Definitionﬂuery‘ Labels ‘Joins&ReIates Time | HTML Popup
Label features in this layer l
Method: l Label all the features the same way. v ‘
Al features will be labeled using the options specified.
Text Sting
Label Field TEXTSTRING v
Text Symbol
[0) aial v|[10 ¥]
AaBbYyZz
[ BRI
Other Options Pre-defined Label Style
[ Placement Properties... [ Scale Range... ] [ Label Styles... ]
I 0K ] [ Cancel ] [ Apply ]

Figure 30 Labelling features

Use the Text Symbol options to set your label styles and click on the Placement Properties button to
set your placement rules.

You can search for help on labelling text here: http://webhelp.esri.com/arcgisdesktop

4.2.2 How to style the data

These instructions use a point feature as an example but the same steps can be followed to style a
line or polygon.

In the Table Of Contents panel expand the layer for styling and click on the symbol to be changed.

Table

=

o]

f Contents 3 Xx

S8

ayers

Meridian 2

[ settlemt_point

O rndabout_paint

O roadnode_point

text

junction_font_point

admin_In_polyline

station_point
mailwav Station symbol

rail_In_polyline

Road Fills group

Road Casings group 1

Road Casings group 2

Qi

L

m

-

D EERE K

+)

+

Figure 31 Customising a point feature

This will open the Symbol Selector window (Figure 32).
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=

Symbol Selector
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v‘ Q @ 22. Curent Symbol

Pentagon 1 Hexagon

e @

1 Octagon 1

Color: C]
Size:
Angle:
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’ Style References. ..
& [ ] & v [ oK ] [ Cancel ]

Figure 32 Symbol selector

In this window the Customer can select a desired style by changing the colour, size and angle.

The customer can use pre-defined styles or create their own. To further edit the feature click on the
Edit Symbol button to open the Symbol Property Editor window (Figure 33).

Symbol Property Editor,

Preview i
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v

5 E3) () [100% »
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@ | . = 2 Offset:
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Cancel ]

Figure 33 Symbol Property Editor

Additional changes to the style can be made here, including adding masks.
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4.2.3 How to save a Layer File or MXD

There are two ways to save the Layer file.

Layer File

One of the main features of a layer file is that it can exist outside a map as a file on disk. This makes it
easy for others to access the layers that have been built.

When a layer is saved to disk, everything about it is saved, such as the symbolisation and labelling.
When a Layer file is added to a workspace it will draw exactly as it was saved. Other Users can drop
these layers onto their maps without having to know how to access the database or classify the data.

Right-click the layer (or group of layers) in the Table Of Contents panel and click Save As Layer File.
In the Save Layer window, navigate to where the file is to be saved and give it a name.

In the Save as type drop-down list specify which versions of ArcMap it should be compatible with. If
the User chooses Layer files (the option without a version number — Figure 34) the layer will be saved
in the version of the software that is being used.

Save Layer,
Lookin: [E C:\Meridian 2 VJ A3 E 8BS
Name: l My Meridian 2 Style.lyr i [ Save ]
Save as type: h aver files (*.lyr) \;‘; Cancel
Laver files (¥ lyr
8.3 Layer files (*.lyr)
9.0/9.1 Layer files {*.lyr)
9.2 Layer files (*.lyr)
9.3 Laver files (*.lyr)

Figure 34 Saving Layer files
Click Save.
MXD

An MXD allows Users to save a map as a document and store it on a hard disk. ArcMap automatically
appends a file extension (.mxd) to the map document name.

The data displayed on a map is not saved with it. Map layers reference the data sources in a GIS
database. This helps keep map documents relatively small in size.

To save the map as an .mxd click on File and then Save as. In the Save As window, navigate to where
the file is to be saved and give it a name.
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Save in: |_)Meridian2 V| Qi@

D

My Recent
Documents

@

Desktop

)

My Documents

93

0S5 Computer
<
05 Network File name: [My Meridian 2 Style.mxzd N ] | Save

Save as type: lArcMap Document v‘ [ Cancel ]

Figure 35 Saving a .mxd

Click Save.

5 Future plans

For the first release of styles Ordnance Survey has focused on supplying them in two major software
formats in the backdrop styles familiar to users of OS VectorMap data.

Ordnance Survey will continue to investigate and develop the styles where appropriate and notice of
this will be published on the Product pages.
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